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Getting Started

Installation

To install the software onto your PC:
1. PlacetheActinicinstallation CD in your CD drive.
2. It should automatically run. If it does not, you will need to:
Click the 'Start' button in Windowstaskbar and go to
'Run'.
Click 'Browse' and then goto 'D:' (where D:isyour CD
drive).
3. Select 'setup.exe’ and double click.
Thiswill start thefirst of the 'Installation Wizards' that will guideyou
through the set-up process. It is possible to achieve a perfectly
satisfactory installation by accepting all the default settings suggested to
you. Click 'Next' to take you from screen to screen, click 'Back' to take

you to the previous screen and click 'Cancel’ to abort the installation
process.
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Starting Actinic

Actinicisdesigned to publish an online store onto theinternet, and then
receive and process orders from that store.

It works by taking all your product data and turning it into a set of web
pages, based on the design optionsyou have selected. It then also
manages all the functionality to control the shopping cart, search and
online security at your online store.

When you first start Actinic, you will seethefollowing screen:

Software Authorization Key. E]E|

“You can enter an autharization key now, ar evaluate the software without entering a key
Authorization

Actinic requires an authorization key. Thiz key can be found inzide the CD caze or can be
purchazed from wour vendor,

Please enter your autharization key in the farm aas-aas-sas-aaa

Exvaluation

Choose the wersion of Actinic you wish to evaluate, up to a maximum of 30 dave, You can if you
wish chooze a different version each time you start the software,

Evaluation Yersion : @

() Evaluate \web Designer VAR product range
Please choose a version v

Click Here for information on the Actinic praduct range.

Dap 2 of the 30-day evaluation period. ‘Your copy expires in 28 days.

“ou can purchase a license frlom:  Actinic Saftware Limited

If you have alicense key for Actinic, enter it in thefield provided and
click 'Authorise'.

If you want to evaluate Actinic then you need to select one of the
'Evaluation Version' options at the bottom half of the window.

To evaluate Actinic Catalog, or Actinic Business select the
'Evaluate M erchant Product Range' option.

To evaluate Actinic Designer select the'Evaluate Web
Designer/ VAR Product Range' option.

Then select aproduct to evaluate and click 'Evaluate'.

You will then see the following screen:

6 - Getting Started Getting Started Guide
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Thisisthe'Content' tab where you can set up the sections and products
in your store, and also seeapreview of the storeasyou build it.

Down the left hand side of the program isthe 'Content Tree'. This shows
you the section, products, pages and information itemsin your store.
Click on the'+'iconsin thetree to expand abranch of the tree. Click on
any item in the treeto seeits details appear in the 'Details' panel to the
right. The 'Preview’ panel might also changeto show you how theitem
you haveclicked on will look in your online store.

There are two other main tabs:

The 'Design’ tab iswhere you can change thelook and feel of
your store pages.

The'Orders tab iswhere you manage and processthe orders
received at the store.

These are both discussed |ater.

You will also see the 'Quick Sart Tutorial'.

L5 X

The Content Tree

The content tree runs down the i Content Tree

e |

[E] More Pages

=] @ Online Catalogue

- =] Books

are underneath

ntain options such as ) Great Expecte
§) Pride and Prej
@ Far From The

=3l Clothing

(o
Froducts
size and

when you click on an item in the
tree, iLs detalls appear Lo Lhe right.

Editing & Previewing

agsic tale of love, crime and des You can make a change to any
setting and then click "Apply' to see
ch. The results will appear in

the preview wi. To see what the
entire s like laid out in web
1ipg pages, clicl [ butten on the

toolbar.

3 Apply changes i Later you'll see how to change the

look and feel of the pages.
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The image shown aboveisfor Actinic Catalog. The quick start tutorial
looks different in Actinic Business and Actinic Designer.

The quick start tutorial is a step by step guideto the main featuresin the
software. Use the arrows at the top right to navigate through the panel.

Exercise - Changing Panel Sizes

This exercise will show you how to change the size of the panelsin
Actinic.

1. Moveyour mouseto the bottom of the Preview panel (which
isdisplaying the current page preview).

2. Now moveyour mouse down slowly into the bottom panel.
Asthe cursor crossesinto the bottom panel it should change

to look like this:

2
=

3. When that happens, click and drag with your mouseto re-
sizethe panels.

4. Now goto 'Window' menu and select 'Restore Initial View
Layout'.

i Wi He

g Content Tree
. Page Freview
=

Page Details - Home

Restore Initial Yiew Layout

Chrl4+5hift+0

Deesign
Orders Ctr+E
Standard Toolbar

Stakus Bar

5. Thisput the panelsback to their original sizes.

Exercise - Rearranging the Panels in Actinic

This exercise will completely changethe arrangement of the panels
within Actinic. Whenever you get into difficulty and don't know how to
fix it, don't forget you can always go to 'Window | Restore Initial
Window Layout'.

1. Click on thetitle bar above the content tree and click and
hold with the left mouse button.

2. Dragthemouseto theright-hand edge of the Actinic
window - asfar asit will go. Assoon as the outline shaps
into avertical column, you can release the mouse.

The content tree should now be down theright-hand side.
3. Now click and drag thetitle bar of the 'Details' panel.

4. Movethe mouse cursor onto thetitle bar of the '‘Page
Preview' panel. You should atab shape appear at the bottom
left of the outline.

8 .
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i Page Details -

5. Assoon asthat happens, release the mouse button.

6. TheDetails panel should now appear 'on top of' the Preview
panel, with tabs at the bottom left to move between thetwo

panels.

More Information - Getting Help With Actinic

The main Actinic help file can be accessed by going to the 'Help' menu

and selecting 'Help Topics'.

E? ActinicMainHelp

0 B

Hide Print  Options

Lontents | |ndex | Search|

|['= [ Getting Started

B} The Main Help File
| E Installation
| 2] The Main Actinic Di:
2] Previewing the Qrlir
E Clozing Actinic
E Site Directories
[2] ihat Is The Quick. !
[2] Changing The Layor
E K.eyboard Shartcuts
E Making Changes in.
[2] Use Parent
= @ Pioducts
2] Q Product Options
[ @ Sections
) Q Brochure Pages & Fragn
[+ Q Business Settings
) Q Shipping and H andling
= 9 Orline Payments
|3 >

=

<

The Main Help File

Down the left-hand side are the help file contents,
Browse down this list to find the information you
need.

Alernatively, click the 'Index’ tab to see the contents
listed alphabetically, or go to the 'Search’ tab to
search for some keywards,

Don't forget that you can click the '?' at the top of
any of the Actinic windows and then click in a field
{ar press F1 whilst in the field} to bring up some help
about that field.

Tl A @

w

Usethe 'Contents' tab of the help to browse by topic. Alternatively, use

the'Index' or the'Search' to locate key words or phrases.

In addition, click on the question mark - € - at the top right of the Details
panel, or any of thewindows within Actinic, and then click in afield.
You will be shown alittle piece of help about the field.

Getting Started Guide
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Previewing

Each separate section (and each brochure page) in the store will
eventually become asingle web pagein your online store.

The Preview panel showsyou what the page you have selected in the
content tree will look like online. If you are finding the panel too small,
or you would like experience more of how your customerswill seethe
site, you can always do a preview. Thisallowsyou to check out your
storedesign in aweb browser.

There aretwo waysto preview

Page Preview - Opens only the current pagein aweb browser.
To do this, click the . button on thetoolbar, go to 'Web |
Offline Page Preview' or press[Ctrl + A] on your keyboard.

Full Site Preview - Previews all the brochure pages and section
pagesin your store, showing you how it all fitstogether. To do
this, click the button on the toolbar, go to 'Web | Offline
Preview' or press[Ctrl + W] on your keyboard.

Exercise - Previewing

This exercise will step you through the two different kinds of
previewing.
1. Makesureyou are on the Content tab.

2. Click on any section (or brochure page) in the store and click
the [B. button on the toolbar. Make sure you click theone
with the single page on the icon and not the double page.

3. Thiswill display your page in your normal web browser.

9 My Company Shoes -

Heb

i1 Program®: 20Fils/Actinic? 20V Stes{Ste1 PreviewtTMLIP index. i

4. Now go back to Actinic and click the button on the
toolbar.

5. Navigatethrough the sectionsin your store (using the links
provided) to view them.

10 - Getting Started Getting Started Guide



6.

Try adding something to the cart. You should get awarning
message. Thisis because you cannot test store functionality
with apreview - only store appearance.

Exercise - Previewing Other Pages

This exercise will show you how to preview pagesthat are not in your
content tree.

1
2.

Go tothe Design tab.

Locate the 'Select Page Type' drop down just abovethe
preview panel on thistab.

WEwr

Type |Content Page © | II ‘

Site Map ~
Terms And Conditions

Add To Cart Confirmation
Shopping Cart.
Checkout Page 0O

Checkout Page 1
Checkout Page 2 ad

Select a page other than 'Content Page'. The page you select
will appear in the preview panel.

You can then click the Bk button to see how this page will
look in aweb browser.

If you are previewing a shopping cart or checkout page within a preview
page, it will contain some example data.

More Information - The Design Tab

The preview panel on the Design tab isdifferent from the one on the
Content tab asit isinteractive. You can click on something in the
preview, and the HTML code for that item will appear in the 'Layout
Code' panel at the bottom of the tab.

For more information about using the Design tab, please see the chapter
called "The Design Tab" on page 66.

Getting Started Guide
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Products

The whole of Actinicis effectively geared around the presentation and
promotion of your products. Consequently there are many options
within Actinic that change how your productslook and work. With
Actinic you can (among other thing):

Enter a stock level for aproduct.

Create an extended information window, containing a larger
image and/ or alonger description.

Set whether the product priceis shown including or excluding
tax.

Set whether adownloadable file will be available to customers
who buy a product.

Set up alist of related items that will appear underneath a
product.

and many more...

Within the content tree productslook like this: Ll

If thereisa'+' next to the product, it is because that product contains
options such as'size' or 'colour’ etc.

Try clicking on some of the example productsthat arein Actinic, and
look at thetabsin the Details panel to seethe sort of things you can
configure on aproduct.

Don't forget you can get information about a setting by clicking on the &
at theright of the Details panel title bar and then clicking in a setting.

Exercise - Adding a New Product
1. Right-click on the'Homeware' section in the content tree.

2. Ontheright-click menu, select 'New Product'.

+ Knitted Sweater -l
=

e @ 1 Copy ChrHC
& Em‘ Offline Page Preview Chrl+a
3 Stati  Mew Fragment Chrl+M

Best  New Section Chrl+5

Mew|  New Sub-Section  Shift+Chles | HOmew

Cut Chrl4i tnas | D
Delete Del
Find Corl+F H
Page Title:
Shanninn b

In the 'Short Description’ field, enter 'Running Shoes'.
4. Inthe'Price field, enter '50.00'.

In the'Full Description' field enter 'Pair of lightweight
running shoes'.

6. Inthe'Image field click 'Browse'. You need to bein the'Sitel'
folder. If you are not there, browse to the 'Actinic
v8\ Sites\ Sitel' folder on your PC.

12 .
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9.

Select 'x-sneakers.jpg' from the'Sitel' folder.

Digital Download Links Marketing Properties Layout
General Details Prompts Prices Discounts Stack Extended Information
Reference:

Short Description: | Running Shoes

Price: 50.00| Use Prices Tab

Full Description:

Pair of ightweight running shoes

Image: wsneakers.jpg [ Hide on ‘web Site
Thumbnail Can Be Didered Online

Category:  Standard -

Switch to the 'Layout' tab and change the 'Price Layout' to

'Standard Tax Inclusive Price'.

Click the 'Apply Changes' button.

Your new product will appear in the content tree and also in the preview

panel.

Exercise - Formatting Text

This exercise will show you how to change the appearance of thetext in
your product description.

1

Highlight the text 'running shoes' within the 'Full
Description' field of your new product.

Press the I button on the toolbar at the top of the details
panel.

Click 'Apply Changes'.

Thiswill makethe text 'running shoes' appear bold in the
preview.

Feel free to experiment with the other text formatting options on the
toolbar to see what effect they have.

Exercise - Extended Information Windows

This exercise will add an extended information window to your 'running
shoes' product.

1

2
3.
4

6.

This change has created an additional 'extended information' page that

Switch to the 'Extended Information' tab.
Select 'Generate Pop Up Page'.

In the'Image’ field, just select 'x-sneakers.jpg' again.

In the 'Text' field enter 'Thisisalonger description for the

running shoes'.

Under 'Display By', click 'Text Link'. In the'Link Text' field

type'Morelnfo...".
Click 'Apply Changes'.

will be opened in apop-up window when you click the 'More Info' text
on your running shoes product in the preview.

In order to seethe effect this change has made, you will need to:

Getting Started Guide
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7. Do afull storepreview by clicking the B8 button on the
toolbar.

8. Then browseto your running shoes, which are currently in
the'Homeware' section.

9. When you get there, click the 'More Info..." link.

7 file: /! - My Company Homeware - Mozilla Firefox g@g\

Running Shoes

This is & longer description for the running
shoes

Done

More Information - Other Product Settings

If you want to ask ageneral question when people buy this product, then
enter the question within the 'Other Info' field on the 'Prompts' tab. You
can also add adate-related question here such as'When would you like
theflowers delivered?.

Wwhiat name would you like on the gift tag?

Usethe'Product Layout' field in the'Layout' tab to try alternative layouts
for this product. If you want a more compact layout, try the 'No Image
No Description Laid Out In SingleLine' layout. Feel freeto experiment
with the different layouts thereto see the effect they have. Change it back
to 'Use Parent' if you want to put it back to theway it was.

Thereis more information on choosing layoutsin “Choosing Alternative
Layouts” on page 62.

It isalso possibleto import awholeload of productsin onego from a
spreadsheet with an 'Import'. Thisis described in the main help in the
section called 'Importing'.

14 - Getting Started Getting Started Guide



Sections

You can use sections to organise your productsinto separate pages - a
section becomes aweb pagein the online store. You can create sections
within other sectionsto create a store hierarchy - and Actinic will
automatically create alink from one section to another.

Exercise - Adding a New Section

This exercise will add a new section to the store, and place your new
'Running Shoes' product within it.

1

Right-click on the 'Clothing' section and select 'New Section'.

Far From The Madding ”
n = Copy ChrH+C tions
EE
+ f Offline Page Preview ChrlH+a
s
5 Mews Fragment Chrl+M
=[5 H on
é Section Shift+Ctrl+S
5 e Wew Product Chrl4P 5 - Clothi
e
Cut; Chrl+
-3 | |
o it be Settings
B¢ Find Ctrl+F
NéwrPronce rageTvame
Page Title:

Note: If you select 'New Sub-Section’, it creates the section within the
current section.

2.

Your new section has been created in the content tree. The description is

Enter aname of 'Sportswear' and adescription of 'A great
range of sports clothes'.

Click 'Apply Changes'.

General | Page Settings | Details | Extended Information | Layout

Mame: | Sportswear

Image: Browse...

Description:

A& great range of sports clothes

[[]Hide on web Site
[[] Exclude from Frongle D ata Feed
L bl e Gt b

Categony:  Standard M

used in thelink to the section on the store front page (visible by clicking
on the green 'Online Catalog' icon in the content tree).

You are now going to drag and drop your 'Running Shoes' product into
the new 'Sportswear' section.

4,

In the content tree click on the 'Running Shoes' product and
hold the mouse button down.

Keeping the mouse button held down, drag the mouse
cursor into the 'Sportswear' section.

Release the mouse button. The running shoes product should

now bein the 'Sportswear' section.

Getting Started Guide
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= Sportswear
ﬁ}- Running Shoes

Heraciu o,

Exercise - Optimising A Section

This section will show you how to use the 'Shopping Mode' feature -
which controls how productsin a section behave when they are added to
the shopping cart.

You will also see afew search-engine optimisation features.

1. Gotoyour 'Sportswear' section and go to the 'Page Settings'
tab.

2. Changethe'Page Name' field to 'sports-clothing.html' (all
lower case).

3. Inthe'PageTitle field enter 'Sportswear: Sports clothing,
tracksuits, running shoes'.

4. Click 'Apply Changes'.

Thesetwo changeswill help your page to be more visible to search
engines.

The next change will remove the '‘Quantity’ field from the HTML page.

5. Under 'Shopping Mode' (on thistab) de-select the 'Use
Parent Settings' checkbox and select 'Quantity in Shopping
Cart'.

6. Click 'Apply Changes'.

Page Mame: spaitz-clothing.himl
Page Title: Sportswear: Sports clothing, tracksuits, running shoes

Shopping Mode

[JUse Parent Settings O Quantity on Product Page
() Quantiy on Confirmation Page
() Quantity in Shopping Cart

Online customerswill now enter the quantity of productstheir require
once they have added product to the shopping cart.

16 - Getting Started Getting Started Guide



Product Options

There are many different waysto add optionsto aproduct. Here are
some examples:

A simplerange of colour options

A range of colour optionswhere each colour isindividually
stock monitored

A range of size and colour options
An extraadd-on that costs extra

A range of optionswhere each choice costs a different
amount

All the above are possible with Actinic, although it is not possible to
demonstrate them all in this guide. Options are created using the
following elementsin the content tree:

Attributes - B2l - These are characteristics of aproduct that
can vary such as'style’, 'length’, 'size, etc.

Choices - 123 - These areindividual optionswithin an
attribute.

Components - ﬁQ - These allow you to create more
sophisticated options such as an optional extra (that costs
money) or arange of optionswhere each option isadifferent
price.

Exercise - Creating Simple Choices

This exercise will allow you to create arange of simple size choices for
your running shoes.

1. Right-click on your running shoes and select 'New Attribute'
2. Giveitanameof 'Sze and click 'Apply Changes'.

3. Now right-click on your 'Size' attribute and select 'New

H \
Choice'.
W T e p———————
= Sportsuwear ‘ m More Pages
= @ Runining shoes . - o J
CH : Attribute Details - Si|
] EEE #
= Homeware Copy Chrl+C
+ ﬁ Teapot CFffline Page Preview Chrl+4
- §) Setof Gl
= Computers Hew Component Chrl+0
-2 stationery Hew Attribute Chrb+1
Best Sellers 5
New Product
Chrl+¥ 5
Delste Del
1
Find Chrl+F
Categony =

4. Enter aname of '8 and click 'Apply Changes'.

5. Now repeat this process to create some more choices for '9,
'10','11', and '12'. You can usedrag and drop to rearrange the
choices if necessary.

Getting Started Guide Getting Started - 17



oSl
= Sportswear

By default, choices appear asadrop down list in your store. If you
wanted to change your choices to radio buttons, you can select an
alternative layout within the 'Layout' tab of the 'Size' attribute.

Exercise - Choice-Dependent Pricing

This exercise will add a new option to the running shoes of 'In-soles'.
When customers purchase the shoes, they will be able to choose whether
they want an in-sole or not, and which type they want - with each one
being a different cost.

Before you can create the new option, you need to put the 'Size' attribute
within a component.

1. Right-click on the'Sze' attribute and select 'Cut’. You will
put it back in amoment.

2. Right-click on the 'Running Shoes' product and select 'New
Component'.

In the 'Name' field enter 'Selection'.
Deletethevaluein the'HTML for Name' field.
Click 'Apply Changes'

o g M w

Right-click on your new 'Selection' component in the content
tree and select 'Paste’.

= g;ortswear ” = Maore Pages
=8 Running Shoes

o i Component Details - Sele
Selection £

= Homeware Copy ChrkC
+- ) Teapot
+-@f) Set of Glasses
e Computers Offline Page Preview Ctri+a
H Statluniry Mews Component Chrl+o F
Best Sellers Mew Attribute cokr P
Mew Products
Cut Chrkex
Delete el =
B
Find CrkF
[TTCEmpanent &5 Separate O
[11s Dptional

Your 'Size' attribute is effectively back to how it was before, but you can
now add more components to the 'Running Shoes' product.

7. Right-click on the 'Selection' component and select 'New
Component'.

8. Givethecomponent aname of 'In-Soles'.

9. Select 'Is Optional' and click 'Apply Changes'.

18 - Getting Started Getting Started Guide



Caomponent Detals:
Companent Name: IS oles

HTHML for Mame: | |n-Sales

1 rs Associated Product
>

Luantity Used:

None -
[[] Component &5 Separate Order Lins { !

15 Optional  [] Selected by Default

10. Right-click on the new 'In-Soles' component and select 'New
Attribute'.

11. Giveit anameof 'Type'.

12. Click 'Apply Changes' and create two choices within the
'Type' attribute called 'Basic' and 'Super'.
+ ‘__J F.TILLETT S dLET

= Spartswear

=i Running Shoes
= @.@ Selection
= Size
123 &
123
123 10
123 11
123 12
= {a.@ In-3oles
= Type
123 Basic
123 Sl
= 'E:‘ Homewware
13. Go back to the'In-Soles' component and select 'Include None
in Attribute Choice List'.

14. Now switch to the 'Permutations' tab and click 'Fill List'.

15. Inthe'Price column next to 'Super' enter '5.00' and click
'Apply Changes'.

Type Walid PFricing Price Praduct,
|: B asic Override 1] UD|[None] Toggle Vald
>| Super Overide 5 UD|[None]

< >

16. Now changeto the'Layout' tab of the component and change
the 'Component Layout' setting to '‘Component Layout With
Selectable Permutations'.

Thislayout includesthe prices of the permutations within the drop down
list.

17. Click 'Apply Changes' to seethe effect.

Getting Started Guide Getting Started - 19



Size

O |

In-Soles Type

More Information - Associated Products

The 'Product’ column in the 'Permutations’ grid (and the 'Associated
Product' fieldsin the 'General' tab) are used to associate productsin the
storewith options. This means you can keep track of the stock levels of
choices by associating each choice with a stock-monitored product in the
store.

You can read more about associated productsin the main help in the
section called 'Product Options'.

20 - Getting Started Getting Started Guide



Brochure Pages

Brochure pages are optional information pages you can include with
your store pages such as'Special Offers', 'Latest News' etc.

There are two example brochure pages supplied with Actinic- 'Home'
and 'More Pages'. You will find these at the top of the content tree. In the
preview, you will see alist of the brochure pagesin the sidebar.

Brochure pages cannot contain products, but they can contain
'Fragments' - which are information items on a page. Sections can also
include fragments.

Exercise - Creating A Brochure Page

Thiswill createanew 'How To Find Us pagein your store, and include
an exampleinformation item within it.

1. Right-click on the'Home' page at the top of the content tree
and select 'New Brochure Page'.

2. Inthe'Name' field enter 'How To Find Us'.

3. Inthe'Button Image' field click 'Browse' and locate
'button_brochure_location.gif' in your 'Sitel' folder.

4. Inthe'Button Rollover Image' field click '‘Browse' and locate
'button_brochure_location_highlight.gif' in your 'Sitel'
folder.

Theseimages are not used in the default Actinic store layout, but they
will bevisiblein other layouts.

5. Click 'Apply Changes'.

General | page Settings || Layout

MName: How To Find Us

Browse..
Browse..

Button Image: button_brochure_location. gif

Button Rollover Image: | button_brochure_location_highlight.gif
Meta Kepwards:

Meta Description:

] Hide on the Web Site

Categany: Standard M

This has created anew pagein the content tree.
You are now ready to include afragment into the page.

1. Right-click on your new 'How To Find Us' page and select
‘New Fragment'.

2. Inthe'Fragment Title field enter 'How To Find Us'.
In the 'Text' field enter 'Hereis how to find our offices...."

4. Changeto the'Layout' tab and change the 'Fragment Layout'
to 'Headline Fragment Layout'.
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- Fragment

Fragment Layout Headline Fragment Layout =
Use Parent (=Fragment Layout Using C55) ~
ragment Layouk Using C55

Image On Left OF Text And Title
Image And Title
Image Only

Image To The Left OF Text
Fragment Layout Image To The Right OF Text
Image On Right OF Text And Title
Layout For your Fragments Text And Titie -

Wariable name is "FragmentLayout”

5. Click 'Apply Changes'.

If you have asuitableimageto usefor e.g. amap then you can always
select it in the'Image' field in the 'General' tab.

More Information - Links

If you are creating afragment that refersto aproduct or asection in the
store, you can usethe'Links' tab to create alink to that item. Then just
include [LINK] in the 'Text' field, where you want the link to appear.
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Uploading Your Store

In order to really see your storein action, you need to upload it to a
website. Thiswill publish your websiteto theinternet, and you will be
able to usethe search, shopping cart and checkout functionality, and
placetest orders.

Exercise - Uploading a Trial Copy of Actinic

If you areusing atrial version of Actinic, which has been pre-configured
to work with a specific site, it issimpleto upload it to the internet.

1. Presstheblueup arrow (%) on the toolbar (or go to "Web |
Update Website").

2. You will be prompted to enter ausername and password.

3. Ifyou do not have ausername and password then you will
need to register for oneonline.

Click on the'To Apply For A New Account' link, and
follow instructions on the website.

Onceyou have supplied the required information and
received ausername and password, enter the username
and password into the fields provided in Actinic.

4. Theupload should then continue.

Check and Send Files

-f Checking HTHML pages...
-’ Checking catalog. .

J Checking search indices.
~ Reviewing files...

-f Sending base files...
J Purging files.

Sending catalog files...

Sending: signature. htrl

Thefirst timeyou upload, it will take quite awhile asit needsto upload
the entire site. After that, however, Actinicwill only upload the files that
have changed.

Onetheupload is completed, click the @ button on the toolbar (or goto
'Web | Browse Website') to view your store online.

More Information - Uploading Actinic To Your
Own Website
Theinstructionsin this section will be applicable to the majority of web

sites, but they won't be applicableto all. If you find they don't work for
your website then you will need to contact your web hosting company.
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When the Actinic storeis uploaded to your web site, all the storefiles
(with afew specific exceptions) are uploaded to two folders on your
website:

'CGI' folder (often called 'cgi-bin') where all the script files
will be uploaded to in order to run the online search,
shopping cart and checkout. These files are sometimes
referred to as 'Perl files'.

A folder called 'acatalog’, which Actinicwill create, that
contains all your store HTML files and images.

Note: The'home' brochure page can be uploaded to the directory level
abovethe 'acatalog' folder' by selecting the 'Use as Web Site Home Page'
box on the'home' brochure page.

Beforeyou try uploading your store you need to know:
The URL ('http:/ /') address of your CGI folder.

Wherethe CGlI folder islocated on your web site (asit
appearswhen you connect via an FTP program).

You will also need to know:

The URL and the FTP location of the folder on your website
that you would like Actinic to create the 'acatalog’ folder
within.

When you have these pieces of information, you can start the 'Web Ste
Configuration Wizard' by going to 'Web | Configure Web Site Details'.

This wizard will step you through the Catalog netwark,
configuration process. This may take a few minutes,
but thiz wizard iz designed to be az simple as possible.
Catalog will make every attempt to automate the
configuration. If you have ta manually establish your
Internet connection, please do sa befare continuing

[[] Canfigure Mew Netwark Settings. If this boxis
unchecked, the wizard will start with pour current ;
settings, :

[] Canfirm Each Setting. If this bax is unchecked,
settings that can be automatically derived and
confimed are hidden,

The Web Site Configuration Wizard will ask you for your username and
password to connect to your website, and will ask you to confirm the
locations, and the http addresses, of the folders mentioned above.

You can often just accept the defaults to achieve a successful upload.

When thewizard has finished, you can review the settings at any time by
going to 'Web | Network Setup'.

From now on, simply click the ® button on the toolbar to upload your
store.

For moredetailed information on uploading, open the main help and go
to 'Putting Your Store Online'.
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Running an Online Business

Business Settings

'Settings | Business Settings' iswhere you can enter details about your
company and how you do business.

Business Settings E]E|
Tax Shipping and Handling Temns and Conditions
Compary/Contact | Oplions Oidering Order Processing || Payment and Security
Caompany

Name.fm | Customer Service Mumber.

Address Registration Information

:My Strest Tax 1 Description: My‘VA.T F\egistra‘fion“ﬂumbel

[ j Tax 1 Mumber:

My Town Tax 2 Description; |
Tax 2 Mumber:

Post Code:

Credit Card Company Ref. | My Merchant 4/C Number
Country United Kingdom -

Contact :

Name: by E_ontacl Tie: |

Job Title by Jaob Title

Phone Number: | My Phone Number Eo e

Email Address, | TouN ame@Y ourCompanyEmai.co \Web Site Address: v YourCampanyServer. com

[ kK ] [ Cancel ] [ Apply ] [ Help ]

You can also set up how you take payments and charge postage, and
these are discussed in later chapters.

It is essential to communicate clearly with your customers on the site
about who you are, whereyou are based, how long it's going to take to
fulfil orders etc. Thisbuildstrust in your potential customers, and makes
them feel more comfortable about placing an order with you. It also helps
set expectations of customers about delivery times etc. to maintain
customer satisfaction levels.

Actinic's main way of communicating all thisinformation isviaan online
‘Terms and Conditions' page. Thisislinked to from every page, including
the checkout, and contains all the information about who you are and
how you do business. Contact information isalso included on the online
receipt, and all emails and reports generated by Actinic.
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Exercise - Entering Company Contact Data

This exercise will show you whereto enter your company detailsinto
Actinic, and also enter information into an onlineterms and conditions

page.
1. Goto'Settings| Business Settings' or click the® icon on the
toolbar. Make sureyou are on the 'Company/ Contact' tab.

2. Inthe'Name' field, enter your company name.

3. Inthe'Address and 'Post Code' fields, enter your address.

Compary

Name: | Smith and Sons LCustome|
Addiess Registral
38 High Street Tax1D

Tax 1N

Anytawn Tax 2D

Tax 2N

Post Code: | ANT 144 Credit Carl

Country United Kingdom -

4. Inthe'Contact' areaat the bottom, enter your nameinto the
‘Name' field.

5. You can delete whatever isin the 'Job Title' field - or change
it to suit your requirements.

6. Enter aphone number in the 'Phone Number' field and an
email addressin the'Email Address field. You can also enter
atelephone number into the 'Customer Service Number'
field at the top.

7. Enter your website addressinto the'Web Site Address' field.
8. Click 'Apply'.
Now you have entered some company details, you can enter some terms
and conditionsinformation.
9. Changetothe'Termsand Conditions' tab.

10. Inthe'Delivery Schedule' tab, change 'We deliver your order
right away' to 'Where possible, we will always ship orders
the same day they arereceived'.

Credit Card 5 ecurity Guarantes Reaching Us
AboutUs | Making a Purchase | Shipping + Hardin

where possible, we will akways ship orders the same day th
received in under <days> days.

11. Feel freeto make any other changesto thetext in the tabs.
You can now check theresultsin thepreview.

12. Goto'Web | Offline Preview' or click the B button in the
toolbar. Make sureyou are previewing the whole store and
not just the current page.
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13. Click the 'Terms & Conds' button (or "Terms' or 'Info’ or
whatever it iscalled in thetheme you are using) to check out
your changes.

Exercise - Tax

In 'Business Settings' you also set up how you want to calculate tax at
your online store.

1. Gotothe'Company/ Contact' tab in '‘Business Settings'.

2. Changethe 'Tax 1 Description' field to read 'VAT Number'
(or equivalent if you charge an alternative type of tax e.g.
'Sales Tax #').

3. Inthe'Tax 1 Number' field, enter your company tax
registration number.

4. Click '‘Apply".
Now changeto the 'Tax' tab.

5. Onthetaxtab click the'Smple option at the top of the tab.

®3Eimple O Adyanced
Tares
Include Tax 1
Description: | WAT
Messzage: WAT payable on European Union orders,
Rate: 17.5000
[ &llows E xemption

o O W

Prompt Pr

This changes tax calculation to 'Smple' mode, where everyoneis charged
the same tax, no matter who they are or wherethey are ordering from.

6. Now changeback to 'Advanced' mode.

'Advanced' modeiswheretax is charged according to where customers
are ordering from.

You usually do not haveto change a great deal here. If you want to
change the standard tax rate being charged do the following:

7. Locatethe'Tax Rates' grid at thetop right of the tab.

8. Changethevaluein the'Rate field to therate you want to
use.

To find out more about configuring tax, look at the chapter called 'Setting
Up Tax', within the 'Business Settings' section in the main help.

More Information - Advice On Selling

The key thing to realise about selling onlineisthat the most important
aspect of it ishow you communicate with your customers - both on the
site asthey customers are browsing, and also after the order has been
placed. A lack of postal address for your company, or unclear
information about delivery times will lose you more orders than adesign
element that is slightly out of alignment. So take thetimeto get your
terms and conditionsright, before getting into the more technical aspects
of the Actinic store.
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Taking Payments

Actinic offers awiderange of options for you to take payment from your
customers.

If you have an existing offline business, and already have the ability to
take credit card numbers, then you may just need away to take credit
card numbers securely from your online customers. Actinic offerstwo
main options for security that both involve SSL - amethod for sending
information securely over theinternet. If you want, you can purchase
your own 'SSL certificate' for your site, and Actinic will work with it. You
might want to talk to your web hosting company about this.
Alternatively, Actinic (and others) offer a'Shared SSL' service that will
allow you to take credit card numbers securely for an annual fee without
needing your own SSL certificate.

However, if you are anew businessyou will need athird-party to
process the paymentsfor you, aswell asreceive the credit card numbers.
These companies are known as 'Payment Service Providers and Actinic
isintegrated with alarge number of them.

Exercise - Changing How You Accept Payment

This exercise will show you how to add a new basic payment method to
Actinic, and also show you how to change how Actinic takes credit cards.

1. Goto'Business Settings| Payment and Security'.
2. Click the'+' at the top left of the main grid.

3. Inthenew row created select '‘Cash On Delivery'in the
'Payment Method' column.

Payment tethod web Sij
Credit card details captured for la... | Credit Cq

¥

Credit card details sent separately | Credit Cq

-
M| Irrvoice with order Invoice
|: Cazh an delivery * [Cash On

Cheque on deliven
Invoice and papment delivery

Payment on account

Thishas now added 'Cash On Delivery' as a payment method in your
store. If you want to removeit, right-click on the grid and select 'Delete

Row'.

Next, you will make a changethat will mean that all customerswill be
required to enter the last three digits on their signature strip when they
enter their card details at the store.

1. Highlight 'Credit card details captured for later processing'
inthegrid (it isusually the top one) and click the 'Configure
Method' button.

2. Inthegrid at the bottom, select 'CVV2 for all payment
methods shown.
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Credit Cards Accepted:

Narmne lssue | CWW2 | CWV2Di.  Startd..
| Mastercard [H] 3 ]
| visa m| 3 0
| Switch 3
B | Switch Wwith Mo lssue Number | [] I} K]

3. Click 'OK".

Exercise - Adding a PSP

This exercise will add a new Payment Service Provider to the list of
payment methods offered by the store.
1. Inthe'Payment and Security' tab, click the '+' at the top left
of thegrid and from thelist provided in the new row, select
‘WorldPay'.

You could select any of the PSPsin the list. WorldPay isjust used herefor
illustration.

2. Changethe'Web Site Description' field in the grid to read
'Online Payment with WorldPay'. This changeswhat is
shown to your customers online.

3. Click the'Configure M ethod' button.

Payment Service Provider Configuration E][E|

‘wieh site description: | nline Payment with \worldPay
Pravider .W;o.rl;:IPay

Merchant
1]

Secret Key

Confirm Key

Operation

() Run in production mode
(%) Alun in test mode
Transaction

(%) Pre-authorise transactions

() Charge transactions immediately

Information and Registration

Thisiswhereyou will enter your account information onceyou have
registered with the PSP.

4. Click 'OK".
You might now want to remove the PSP from the list of payment
methods.

More Information - Finding Out About PSPs

The Actinic web sites (http:/ / www.actinic.com/ and

http:/ / www .actinic.co.uk/ ) contain alist of the payment service
providers (also known as'payment gateways') that work with Actinic. It
isworth shopping around to see who can offer the best deal. Most PSPs
will take a percentage of the transaction value, but some also offer a fixed
cost per transaction (worthwhileif you sell alot of high-value goods).
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Shipping Charges

Actinic allows you to charge your customers for shipping their order to
them. There are two approachesto charging for shipping:

Useasimpleratethat is easy for customersto understand.
You could base this on how many productsthe customer has
bought, or base it on the value of the order.

Use amore sophisticated calculation system that works out
more precisely what the order will cost to ship, and passes
that cost onto the customer.

However you want to charge shipping, Actinic has arange of toolsto
meet your needs.

Exercise - Adding A Shipping Class

This exercise will add a new shipping class to the ones offered by your
store. It will charge a set amount per item ordered.

1

Go to 'Business Settings' and change to the 'Shipping and
Handling' tab.

Under 'Calculation Basis' (down theleft hand side) change it
to 'Total Quantity'.

Shipping | Handling
Calculation basis

O Simple

() Total weight

[Free over

You will always be able to change it back to 'Total Weight' (the default)
after trying this exercise.

3.

Right-click on the 'UK' shipping zone (in the white box in the
middle of thistab) and select 'Add Class' and then 'New
Class.

In the'Name' field enter 'Test Rate'. You can leavethe
'Description’ field blank.

Click 'OK".
Now with your 'Test Rate' shipping charge selected go to the
grid to theright and click the '+' at the top left of the grid.

In the new row created, enter '1' in the 'Quantity' column and
'0.75"in the 'Cost' column.
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Shipping bands
@ ByZone O By Class E] Quantity Cost

=T i EU?El
Test Fate
Second Class Post
First Class Post

+- North America
+- Rest of EU

Excess

(@ Don't allow excess

() Take the highest value in the table
() Increment highest value in table by

per

8. Now click the'+' again and in the new row enter '2' in the
'Quantity’ column' and '1.50' in the 'Cost' column.

9. Now goto the 'Excess area below the grid. Select 'Increment
the highest valuein thetable' and in the top box enter '0.50'
and in the bottom box enter '1'.

These settings you have entered will charge 0.75 for the first product,
then another 0.75 for the second product, and then 0.50 for each product
after that.

Exercise - Exempting Products From Shipping
Charges
It issimpleto prevent certain products from incurring shipping charges.

1. Goto'Business Settings| Shipping and Handling' and set
the 'Calculation Basis' to 'Total Weight'. It way be set as this
already.

2. Select the 'Test Rate' ratein thewhiteareain the middle.

3. Inthegrid totheright, click the'+' at the top left to createa
new row.

4. Leavethe'Weight' field as'0.00' and the'Cost' field as'0.00'.

Click 'OK" to close 'Business Settings' and then click on a
product in the content tree.

6. Inthe'Details' tab of the product enter '0.00' in the 'Weight'
field at the bottom |eft.

Shipping Details
Wwieight in kg 0

Now whenever anyone buysthis product, Actinic will seetheweight as
being '0' and so it will giveit afree shipping charge.

More Information - Issues Around Shipping

Whoever you choose to ship your products with, make surethey havea
clearly detailed procedure for handling lost items, and also for tracking
parcels. Thisjust meansyou can deal with any complaints about lost
ordersas quickly and as efficiently as possible.
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Marketing and Promotion

Best Sellers and New Products

'‘Best Seller Lists' and 'New Products Lists' arelist of products that can
appear on every page (or just on specific pages) to promote certain
productsto your customers.

Best sellerslistswork out the best selling products from the orders that
have been received, and display them as alist in the store. The best
selling itemsin your store arethe ones that most people will cometo
your siteto buy, so by displaying them prominently in your store you
will help customersfind them more quickly, which will hopefully turn
into more new orders.

New products listsare made up of the newest itemsthat have been
added to the store. It isimportant to keep displaying your new est
product lines as this keeps your store content current and up to date and
hopefully gives customers areason to keep coming back to your store.

By default in the example Actinic storethereisanew productslistin the
sidebar of every page, and also on the brochure home page.

Exercise - Adding A Best Sellers List
This exercise will add a'Best Sellers' list to your store pages.
1. Goto'Marketing| Best Sellers'.
Thelist isalready enabled, and may already have some products within
it.

2. Click 'Generate Now'.

32 -

Marketing and Promotion

Getting Started Guide



Enabled
Murmnber of Products in Lists 6
Period of Sales to Process :
® Include Sales from Jast |30 | Daps
O Include Sales from ~ | to

Auto-Generate List on Upload

(&) Every ‘.1 1 Days (O Every Upload O Newer

BestSellers List

Ord

F’rod]cl Lock 7»_\_
i{ P of Casual Sh..

1
2|Knitted Sweater
3|Basic T
4
]

Pride and Prejudice

gjoo|ojc

Box of Staples

[ (u]: H Apply ][ Cancel ]

Thiswill search through thedemo ordersthat arein Actinic and work
out the best selling items from that.

3. Now click 'OK" and check out the site. You should see a best
seller list in the sidebar of every page, and also one on the
home page.

Best Selling Items

to be missed

! Pair of Casual Shoes i Knitted Sweater i ! Basic
H £60.00 o £30.00

9 This quality ! Comfortable,

LY vintagestyle | hemvweight

: footwearis not | | and durable- | |

| this sneateris 1 |
1 find out mare made from
H 100%

lambawn ol

nd out more

i Pride and Prejudice 1| Box of Staples | Startg

4. Now goto'Marketing| New Product Listing'.

Click 'Generate Now'. Therunning shoes should be added to
thegrid.

6. Click 'OK"and you should seetherunning shoesin the 'New
Products' list on the sidebar of each page.

New Products

Funning Shoes

£58.75

Fair of
lightweight
running shoes
find out mare

Exercise - Changing Where The Lists Appear

This exercise will allow you to control where the best sellers and new
productslists appear in the store.
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1. Goto'Settings| Site Options and change to the'Layout' tab.

2. Find the'Best SellersList' sub-heading at the bottom of the
grid.

3. Changethe'Location For Best SellersList' setting to 'Home
Page Only".

4. Now under 'New Products List' change the 'Location for
New Products List' setting to 'Sidebar Only'.

= Best Sellers List
Best Seller Item Layvout (For Section Pages) Use Parent (=Full Best Seller Layout Using C55)
Best Seller List Layout {For Sidebars) Sidebar Best Sellers List
Eiest Sellers List Layout (For Section Pages) Full Best Sellers List
Lacation For Best Sellers List Hame Page Only
= Mew Products List
Location For Mew Products List Sidebar Only =]
Mew Products Item Layout {For Section Pages) Use Parent {=Eoth Sidebar and Home Page)
Mew Products List Layout (For Section Pages) Both Sidebar and Home Page
Mew Products List Layout For Sidebars) Home Page Onl vy

5. Click 'OK".

You should now have best sellerslist appearing on the brochure home
page and the new products listing appearing in the sidebar of every

page.
Note: If you try and change the 'New Products List Layout (For Sdebars)'

or the 'Best Sellers List Layout (For Sidebars)' it doesn't change anything
in the default 'Executive theme, but it will have an effect in other themes.

More Information - Fixing Items In the List

If you go to thegrid at the bottom of ‘Marketing | Best Sellers' or
'Marketing | New Products Listing' you can click on any item in the list
and usethedrop-down list to manually changeit to a different item.

Using this method it is possible to manually configurethelist if there
certain products you want to promote, or certain products you don't
want to promote. You can also click the 'Lock' checkbox to fix that
product in thelist and let all the other products auto-generate around it.
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Related Item Lists and Also Bought Lists

Aswell asthe best seller lists and the new productslists discussed in the
preceding chapter, it is also possible to display lists of products
underneath each product in the store. There are two types of thesellists:

Related Product lists - where you can configure alist of
other productsthat arerelated to aproduct, and then display
them on the online storewith alink to the related product.

Also Bought lists - (Actinic Business/ Designer only) - these
are automatically worked out by Actinic. Actinic can take a
product in your store, then look at all the ordersthat include
that product, and then look at what else the customers order.
These then become a 'customers who bought this also
bought..." list underneath the product.

Aswell asappearing underneath productsin the store, these lists can
also appear on the shopping cart pagein the online store. That way,
customers can see some productsthat arerelated to the products that
they already havein their shopping cart.

Exercise - Creating a Related Products List

This exercise will include arelated productslist for the 'Basic T' product

in your store.

1. Goto'Marketing| Related Products'.

2. Select 'Enabled'.

3. Click 'OK".

4. Now gotothe'Basic T' product (within the 'Clothing'
section).

5. Gotothe'Marketing' tab and click the '+ at the top left of the
'Product Related Products' list.

6. Intherow created, choose'Premium T' from the drop-down

list.

Thisisan example of how you might usetherelated productslist to
create an up-sell from one product to another.

7.

8.

Now click the '+' and thistime select 'Pair of Sandals' from
the list.

Product Related Products List

Order Product

F

:

Click 'Apply Changes' and check out your changesin the
preview.

Exercise - Also Bought Lists

Actinic Business/Designer only
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This exercise will generate 'customers who bought this also bought..." lists
into your store, and show you how to change the layout of them.

1. Goto'Marketing| Also Bought...'
2. Select 'Enabled’ and then select '‘Generate Now'.

Also Bought List Generation

-f Generating Product Also Bought Lists

3. Click 'OK’
Thiswill generate alist for nearly every product in the default store.
4. Go back to the 'Marketing' tab for the 'Basic T' product.

You should see that some products have been automatically added to the
list. These products will appear in afairly standard numbered list by
default, but there is an alternative layout option.

5. Goto'Settings| SiteOptions| Layout'.

6. Under the'Product’ sub-heading, find the 'Product Also
Bought Item Layout' setting.

FIICE TayToT TISE FarET =N arT TEx CRCISTFE FTICES
Product Also Bought Ttem Layaout Mini Also Bought Item [E3)
Product Layout

Product List Layaut I ‘ - n
Product Related Products Ttem Layout Als Boudht Ttem Vrith ya
Width OF Product List 500

=

7. Changethissetting to 'Mini Also Bought Item' and click 'OK".

This should include an image, price and description into the also bought
list for the 'Basic T'.

People who bought this item also bought:
Knitted Sweater

£30.00
Comfortable, heavyweight and dutable - this swe
find out mare

Pride and Prejudice

[“:’_:T‘ﬁ £4.00

ioy  Jane Austen's classictale of intrigue, suspense an|
| !an!

Therelated itemslist also has an equivalent layout option.

find out more

More Information - Lists in the Shopping Cart

Onceyou enable either related item lists or also bought lists you will see
alist appearing in the online shopping cart underneath the grid of
products. These lists show therelated products and also bought products
for the product that is currently in the shopping cart. If thereis more than
one product in the shopping cart, then Actinic will merge all therelated
products and also bought productsinto asinglelist.
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Mailing Lists

Actinic gives you the ability to easily extract your customers' contact
details out of Actinic. Thisinformation can then beimported into
emailing programs like Microsoft Outlook or GroupMail in order for you
to mail your customers with promotional material.

Thisfeature can be found at 'Marketing | Mailing Lists'.

[ —
Marketing | Wweb Housekeeping  Window  Hel
=Y Best Sellers... 2

®

Mews Product Lisking. ..
— Also Bought. ..

Related Products...

Discounts and Surcharges Settings. ..
~ 2| Customer Groups..,

Produck Groups. ..

T
-

| Mailing Lists. .. N

Export Froogle Data Feed...

All versions of Actinic allow you to filter your customers' contact details
based on when they placed orders, and what the status of the order is.
Actinic Business/ Designer customers can go further and filter thelist
based on what productswere ordered, wherethe customer islocated and
how largethe order was. With Actinic Business/ Designer, you can also
print mailing list information onto labels and envelopes.

Exercise - Creating a Mailing List

This exercise will show you how to build amailing list based on the three
example ordersthat arein the'Orders' tab in Actinic.

1. Goto'Marketing| Mailing Lists'.

Mailing Lists Rx
Order Details Options Preview
Main Select Products Product Search Location Lookup
Dates: Order Status:

(3 Order Placed (O Order Completed (O Order Recejved [ Ay

Eom [[]14 June 2005 v | (oo 2
Too |14 dune 2006 v| [z3mame 2
Fayment Status:

Order Payment Status: :Any B ] [AND) Purged

Include Address Details From:
Inyoice Sddress [ Delivery Addiess

Export Cugtomers

Filter On User Defined Fields:
[ User definable 1 Walue: [
[ User definable 2 Walue: |
[ User definable 2 Value, |

[ Only Include Orders From Registered Customers

Filter On 'keep Details Private”
() lgnare this setting

(2 Include when ticked

() Include when nat ticked

E‘.F'reweﬂhgtm Export List F\Iename:; [:]

&

2. Under 'Order Status, de-select 'Completed' and select '‘Any'.
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3. Inthe'From'field, make surethe dateis somewhere before
May 25th 2006 - asthat iswhen thethree example orders
were created.

4. Makesurethat 'Order Payment Status' is set to 'Any".
5. Click the'Preview List' button.

Preview:

E-mail Addiess Name Title Home Street
jacksmithi@yourcompanyem...  Jack Smith bdr Arywhere
janesmith@yourcompanyem... Jans Smith bdrs Anywhere
jsmith@yourcompanyemail.c... John Smith tdr Anywhere

This showsyou the three sets of customer datathat are ready to export.
6. Inthe'Filename field, enter 'export.csv'.
7. Inthe'Format' field, select 'SSandard Format'.
8. Click 'Export List'.

Thefilewill be created in the'Actinic v8' folder by default.

Actinic automatically removes any duplicate records, based on the email
address supplied with the order.

Exercise - Advanced Filtering
Actinic Business/Designer only

This exercise will show you how to filter the mailing list based on
whether customers have ordered the 'Knitted Sweater'.

1. Goto'Marketing| Mailing Lists' and go to the 'Select
Products' tab.

2. Click 'Get Products'.

3. Inthetree, click the'+' next to 'Online Catalogue'. Then click
the '+' next to 'Clothing'.

4. Select the'Knitted Sweater' checkbox.

2 O
-]

Online Catalogue
Books
Clathing

Shoes
Basic T
Prernium T

3

Enitted Sweater
Homeveare
Computers
Stationery
Sportswear

Best Sellers

New Products

- - -

o o

5. Now go back to the'Main' tab and make surethat the 'From’
field is set to sometime before May 25th 2006.

6. Finally, pressthe'Preview list' button to updatethelist. It
should only contain 'Jack Smith'.

Filtering can also be done on location (in the 'Location Lookup' tab) and
order size (in the 'Order Details' tab).
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Order Level Discounts

Order-level discounts are availablein all versions of Actinic, including
Actinic Catalog. They allow you to create discountsin the storethat are
triggered by how much the customer has spent online. For example, you
can use thisto create a discount that says "10% off all orders" or "£10 off
all ordersover £75".

Exercise - Creating a Discount Based on Order
Value

This exercise will create a'weekend sale' where all orders have 10% off
within a set time period.

1. Gotothe'Marketing' menu and then select 'Discounts and
Surcharges Settings...".

2. Gotothe'Order Level'tab (if you are not on it already).

3. Click the'New' button at theright and enter a name for your
discount of 'Weekend Sale'.

Order Level | Cart Contents | Customer Pricing
Discounts:
Description:
weekend Sale

New Bemove

4. Changethe'Based On' field to 'Cart Value Including Default
Tax'.
5. Change 'Type' to 'Percentage'.

6. Inthe'Triggers grid click the '+' at the top left and enter a
value of '10' in the 'Percentage’ field.

7. Click 'Apply".

General | Restrictions

Properties:

[Z]Enabled  BasedOn:  CartValue Including Defa = T¥PE! Percentage

[ Requires Coupon Code:

Triggers
Cart Value Amaoint Percentage | Surcharge
|: 2000 oo | O ‘

Thiswill put adiscount on your storeright away, so before you upload
and test this, you are going to restrict the discount to only being for this
weekend.
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8. Changeto the'Restrictions' tab (within the'Order Level' tab).

9.

In the 'From' field select the upcoming Saturday.

10. Inthe'To' field select the upcoming Sunday.

[Drate Restrictions

alid From:
24/06/2008

Walid Until:
25/0B/2006  w

11. Click 'OK®

There will now be a 10% discount on all orders placed at your store for
the coming weekend.

Note: you may want to remove this discount if you are about to put your

storelivel

Exercise - Credit Card Surcharges

This exercise will apply a surchargeto your storeif acustomer choosesto
pay viadebit or credit card.

1

Go to'Marketing | Discounts and Surcharges Settings |
Order Level'

Select the 'Credit Card Surcharge Example' discount that
should already bein thelist.

Make sureyou are on the'General' tab.
Select the 'Enabled" checkbox.

In the 'Triggers' grid, change the 'Percentage’ value from '2.0'
to'l5".

Discounts and Surcharges Settings @El

Order Lewsl | Cart Contents | Customer Pricing | Miscellaneous

Discounts:
General | Restrictions

Propetties

Description

[Credit Cart Surcharge Example

Mew Remove

[FlEnabled  Based O CattValue Excluding Tax = 1¥9%0 Percentage

[] Rreguires Coupon Code:

EE Triggers

Cait Suicharge Examp
Mieekend Sale

.,
B

CatValie | Amount Percentage  Suicharge
I 2001 £0.00 150 |
|[2]
[ o J[ canced [ gk [ Heln |

Notice that the 'Surcharge' box is selected. This means that the percentage
value herewill be added to the order value.

6.
7.

Now changeto the 'Restrictions' tab.

Noticethat the 'Restricted to Payment Method' box is
selected, and the list contains 'Credit card details captured
for later processing'.
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If you wanted to select adifferent payment method (such as a PSP) you
can select an alternative onein thedrop down list in the grid
8. Click 'OK".

You can now upload the storeto test what effect this discount has online.

More Information - Restricting Discounts

In the exercise above you restricted adiscount to a daterange. You don't
have to set both the 'For' and 'To' fields - you can set one or the other if
you want to start adiscount now and end it on a certain date, or start a
discount on a certain date and let it run indefinitely.

Additionally, if you areusing Actinic Business/ Designer, you will seein
the 'Restrictions' tab thereis also a 'Restricted to Customer Group' grid. If
you wanted a discount only for your retail customers or for specific
customer groups you can usethegrid to set it up.

Customer groups arediscussed in alater chapter.
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Advanced Discounting

Actinic Business/Designer Only

Aswell as creating discounts based on order value, Actinic Business and
Actinic Designer allow you to create discounts that are based on the
itemsthat are in the shopping cart. This allowsyou to set up discounts
such as '3 for the price of 2' and 'Buy any three booksfor 5.00'.

Thereisan example '3 for the price of 2' discount already set up in the
'‘Cart Contents' tab in 'Marketing | Discounts and Surcharges Settings'.

Also, you have the option to activate any of the discounts by customers
entering a specific coupon code online.

Exercise - Buy Both T-Shirts for 10.00

This exercise will create a new 'Fixed Price' discount for the two t-shirt
productsthat arein the default database. The first thing you need to dois
tell Actinic that thetwo t-shirts arerelated to each other. Thisis done by
putting them both into a'Product Group'.

1. Gotothe'Marketing' menu and select 'Product Groups'.
2. Click 'New' and enter aname of 'T-Shirts.

3. Select the'Basic T' product from the right-hand list and use
the '<' button to moveit to the 'Members' list.

4. Dothesamefor the 'Premium T'.

Product Groups E]El
Groups Froduct Assignments
Bt e Members Unassigned Products -
|Basic T (5] 3
1 Premium T 5] 17 inch Manitor [15)
19 inch Manitor [16)
21 inch Manitor [17)

Box of Paperclips [19)
Box of Pens [20)
Box of Staples [18)
Kritted Sweater [8)
Pair of Casual Shoes (9]
Pair of Sandals [10]
Professional Computer Bundle [14]
Fiunning Shoes (4]
b ok 2 EE

]ProFEssionaI Computer Bundle (1‘.1)|
Teapat [11]

Seach

Other Options
] @y Apply One Discount Online for This Group

5. Click the 'Discounts' button and click 'OK' on the message
that appears.

You should now be on the 'Cart Contents' tab within '‘Discounts and
Surcharges Settings'.

6. Click 'New' and enter a discount name of 'T-Shirt Offer’.
7. Change'Based On'to 'Quantity".
8. Inthe'Trigger' field, enter '2'.
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9.
10.
11

12.
13.
14.

15.

Change'Product Group'to 'T-Shirts'.
Change'Reward Type' to 'Fixed Price'.
In the'Reward Amount' field enter '10.00'.

General | Restrictions | Presentation

Properties:

[#]Enabled  Based On Cuantity - Triggen 2

[ Requires Coupon Code:

Product Group T-Shirts: -

Rewards:

Reward Type:  Fised price - Reward Amaunt: 1000

[] 0rly One Reward Per Order

Click 'Apply".
Changeto the 'Presentation’ tab.

Enter the following text: 'Buy both t-shirts together for only
10.00'.

Click 'OK".

The 'Buy both t-shirtstogether...' message will appear underneath the
descriptions of both t-shirt productsin the preview, and will also appear
in the shopping cart.

Exercise - Coupons

This exercise will set up adiscount that isonly triggered when customers
enter acoupon code online.

1

Gotothe'Order Level' tab within 'Marketing | Discounts
and Surcharges Settings'.

Highlight the 'Weekend Sale' discount you created in the last
chapter.

If you don't have this discount set up, then highlight the 'Order
Adjustment Example' discount that is provided with the default database
and select 'Enabled’.

3.

© N o g M

Select the 'Requires Coupon Code' box.
Enter a coupon code of '12345'.

Click 'Apply".

Now changeto the 'Miscellaneous' tab.
Under 'Coupon Codes' select 'Store Pages'.

Click 'OK"

Coupons

If wou have a coupon for our shop
then erter i here:

Coupon Code

This should insert a coupon entry field into the sidebar of your store

design.
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More Information - Offering Products as
Rewards

One of the'Reward Type' optionsyou havein the'Cart Contents' tab of
'Discounts and Surcharges Settings' is 'Money off extra product’ and '%
off extra product'. These allow you to offer customers free/ cheaper
product as part of apromotion.

The'extraproduct' in question isany product from a specific product
group that you have set up in Actinic. If you want just to offer a specific
single product then you will need to create a product group that just
contains that one single product.
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Day to Day Administration

Retrieving Orders

To retrieve any orders placed at the store, click the green down arrow
(i) on the Actinic toolbar, or go to 'Operations| Retrieve Orders'.
Actinic will connect to your store and seeif there are any orders on the
sitewaiting to beretrieved. It then downloadsthem and liststhe orders
within the'Orders' tab. You can view the details of an order by double-
clicking on it.

Some people check for new orderstwo or threetimes aday (or more). If
you are not expecting that many ordersto be placed at your store, you
can just check your email inbox for '‘New Catalog Order Received'
notification emails. This email is sent just after the first order is placed
after themost recent order download. You will then know thereis at
least one order to download.

Note: You must select the 'Send me an Email When | Have an Order to
Download' checkbox in '‘Business Settings| Ordering' to have this email
sent to you.

Exercise - Downloading and Viewing Orders

This exercise will show you how to download and view order details
with Actinic. You need to have placed sometest orders on thesitein
order to have anything to download.

1. Onceyou have placed one or more test orders at your Actinic
store, switch to the 'Orders' tab.

2. Click the green down arrow (i) on the toolbar.

3. Your order should then belisted in thelist on the 'Orders'
tab.

Eg Content ||[Bf Design B Orders

Order Mumber Uszer Payment
ord D'E R 00000000001 Pending
o DER 0000000002 Pending
orf DEMO0000000003 Pending

Note: There arethree demonstration orders already in Actinic.
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4. Doubleclick on your new order to open it.

Order: DEMO0000000001

"% Line Ttems | Shipping and Handling | Taxes | Totals | Progress and Payments | Misc. | Mail

Journal

Irvoice Contact

Delivery Contact

Salutstion: |Mr_| (7] Keep detalls piivate Sautation: M1 | [ Keep Detalls Frivate

Name Jshn Smith Name: Jshn Smith

Titl: Tile

Company: Compary.

Adchess Anywhere Address Anywhere

Anytown Anytown

Postal Code: | ANY 123 Postal Code: | ANY 123

Courtry Urited Kingdom Eauny United Kingdom

Phare: 01234 567830 Phene: 01234 567830

Fa Far:

Email: jemith@yourcompanyemail. com Email jemith@yourcompanyemail. com

User Defined User Defined

Evtemal Fief, Extemal Ref

Location: United Kingdom ~
Urited States =
Canada
o &
Db
[ oK [ Apply | [Reptirt Packing List| [_Repiint Invaice | [ Delets ]

5. The'Customer' tab showsyou the name and address
information supplied with the order.

6. Changeto the'Lineltems' tab. This showsyou theitemsthat

have been ordered.

7. Changeto the'Progress and Payments' tab. This showsyou
the payment information entered at the store.

8. Now click the 'OK' button to closethe order.

In the next chapter you will see how to process an order.

Exercise - Creating a Packing List

When you receive new orders, you can print a'packing list' for each
order, which can be used when making up the order, and also can be
used as adelivery note on the front of the package sent. This exercise will

show you how to print packing lists.

1. Goto'Operations| Report Selection'.

2. Changeto the'Order Processing' tab.

Reports, Export and Mail

EataInEJ Order Processing iSaIes | Export | Email |

Outstanding Products
Outstanding Invoices

Outstanding Credit Card Schedule
Outstanding Preauthorized Scheduls

Lopies

Report options

Frinter Settings

r
=

-
| =]

[ Frrint I [ Preview ]

[ PFrinter Setup ] [

Close ]

3. Select 'Outstanding Packing Lists'.

4, Click 'Preview'.
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Thiswill lay out the order information within a packing list report.

B Actinic Packing List Report

1ot3 (Y] T00% w|  Tod  100% 30t3

Order no.: DEM
My Company
My Street
My Town
United Kinadam
Phone: My Phone Mumber
Email:  YourMame @Y ourCampanyEmail.com Web Site: www Y ourCompal

Packing List

Invoice Address: Deliver to: _—

Mr John Smith MrJohn Smith
Anywhere Ampwhere
Anytown Anylown
ANY 123 ANY 123

United Kingdom United Kingdom
Phone: (01234 567890
Email: jsmith@y aure ompany email.com
Phone: 01234 567890
E mail: jsmith@y oure

More Information - Assurances

Ordersare encrypted to two levels on the site. Any credit card
information is encrypted with a 1024-bit encryption key - which you can
view by going to 'Housekeeping | Security'. The name and address
information isthen encrypted aswell, but with alighter level of
encryption asthat information isless critical.

Ordersare stored asfiles on the website with an extension of *.ord. Once
theorder isfully downloaded into Actinic, Actinicwill send up a
command to the web site to delete the order fileson the site. Thisonly
happensonce Actinicis surethe order has been safely received.
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Processing An Order

Thereisaset of order processing tools built into Actinic. Some are
optional, and some arerequired - i.e. Actinic will not consider an order as
being 'complete’ until you carry them out. The required order processing

steps are:

Thelines of the order must all be marked as 'shipped’ or
‘cancelled’. Thisis shown below.

All paymentsfor the order must be marked as being
'received’. Thisis shown below. If you are using a PSP
(Payment Service Provider) the payment will be taken online
and so the paymentswill be marked asreceived as soon as
theordersareretrieved into Actinic.

Aninvoice must be printed for the order.

Alternatively if you don't want to process orderswithin Actinic then you
can select the '‘Bypass Catalog Order Processing' option in 'Business
Settings| Order Processing'.

g

Order Processing:

Thiswill mark the order lines as shipped and the payments asreceived
assoon astheordersareretrieved. You can then do one of the following

actions:

Print a'Data Entry' report. Thisisasingle piece of paper
containing every piece of information about an order. To
enable thisfeature, you need to select 'Enable Data Entry
Reports' in 'Business Settings| Order Processing'. To print a
data entry report, select 'Outstanding Data Entry Reports' in
the'Order Processing' tab of the 'Operations| Report
Selection' window.

Export orders. This exports order information as a set of csv
spreadsheet files for importing into another application. This
istypically donein conjunction with 'Actinic Link' - Actinic's
accounts integration package (Actinic Business/ Designer
only). To enable exports, select 'Enable Export to Files' in
'‘Business Settings| Order Processing'. To carry out an
export, go to 'Operations| Outstanding Exports'.

Exercise - Processing an Order

This exercise will show you how to use Actinic'sin-built toolsto
completeanew order. This exerciseisbased around order number

'DEM O0000000001' in the example Actinic database, but you could easily
carry out these stepswith any order.

1

2
3.
4

Changeto the'Orders' tab (if you are not there already).
Double-click on order number 'DEM O0000000001" in the list.
Changeto the'Line Items' tab.

Highlight 'Great Expectations' and click the 'Ship' button.
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Custamner | Line Ikems | shipping and Handling || Ta

Product Description Ma. Ordered . Nof
ectations
ord Pair of Casual Shoes 1
Size: 11
ord Teapot 1
Selection - Size: 5 Cup 1

If the 'Ship' button is not available, it might be because you have selected
'‘Bypass Catalog Order Processing' in 'Business Settings | Order
Processing'.

5. Highlight 'Pair of Casual Shoes' and click the 'Ship' button.
6. Highlight 'Teapot' and click the 'Ship' button.

Obviously if you have different order contents, then ship whatever order
lines arein thetab.

7. Click the'Mail' button. Thiswill generate an 'Order Shipped'
email ready to be sent to the customer.

Mail @E‘
s o] Layout  Drde Shipped Emai -

Subject: | My Company : Order DEMODDDDO0OD! : Order Shipped Email

DearJohn Smith, -~

The follawing arder has been shipped to your defivery address:
__Ivaice Address and Defiver T
Email Address: jsmith@yourcompanyemal.com

__Customer/Recipient Detalls

MrJahn Smith

Anyhers

Anytown

ANY 123

United Kingdom

Fhane Number. 01234 567850
Fa Mumber

_ Ordler Status

gendrow | [ Done | [ Cancel

8. Click 'Done.

You can view the email in the'Mail' tab of the order. And send it by
going to 'Operations| Send Mails'.

9. Changeto the'Progress and Payments' tab, and click 'OK" on

the warning message that appears (you might want to select
the 'Don't show this message again' box).

10. On the'Progress and Payments' tab you should see the
demonstration credit card details. Click the 'View Payments'
button.

11. Click 'New Entry' and then click 'OK".
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@)

Payment History for Order Number: DEMO0000000001

Date Status Transaction Amount
13/06/2006 09:40:00 Received Credit card debit £H361
Datedtime Created | 13/06/2006 03:40:00 Status Received -
Mode Production Transaction Credit card debit -
Tupe Manual Amount 8361
Comment CC Auth, Code
PSP Provider Ref
Cuztomer Bef
PSP Rezponse
Datertime Actioned |13/06/2006 D3:40:00
[ ok ] | MewEntry | [ Delete ] [ Cancel ]

Thishas made an entry in the payment history of the order saying that
the credit card payment has been received. You would normally only do
thisonceyou have put the credit card information through a credit card
terminal.

12. Click 'OK'to closethe order.

13. Goto'Operations| Report Selection' and make sureyou are
on the'Order Processing' tab.

14. Select 'Outstanding Invoices' and click 'Print'.
15. Thiswill print theinvoiceto your printer.

The order should now have disappeared from the 'Orders' tab. You will
find it by going to the 'Completed' tab (change tabs at the bottom of the
window). The order is now marked as completed.

Exercise - One-Click Order Processing

Rather than doing each step of the above exercise, it is possible to pre-
configurethe things you want Actinicto do to each order, and then
simply 'Complete' the orders with asingleclick. Thisis described below.

1. Goto'Business Settings| Order Processing'.

2. Select 'Enable One-Click Order Completion' (if it is not
selected already).

Select 'Print Packing List'.
4. Select 'Mark Packing List Printed'.

One-Click Order Completion
Enable One-Click Order Completion

Create Full Payment Pririt Packing List
Ship Al Lines Mark Packing Uist Printed

Frint lrrvoice
Send Email Mark, Invoice Printed

Email Template:  Order Shipped Email

4

Click 'OK".
6. Now right-click on any order in the 'Pending' tab and select

‘Complete Order'. Or highlight an order and click the
'‘Complete' button.
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Order Mumber Lser Payment | |
ord DEMO0000000001 Full Pay..

urd DEMO00000D]  View Ordder...
Mew Order

Delete
Back Order

Reprint Standard Packing List Report
Reprint Standard Invoice Report
Crder Summary

Highlight Colour 3
Find...
Find Ordered Products...

The order should moveto the 'Completed’ tab.

More Information - Full Order Details
All thetabswithin an order are described below:

Customer - Thisiswhereyou can view and edit the
customer contact information.

Line Items - Use thistab to ship items, and cancel them. You
can also click the'Add New Item' button to add a new
product to the order.

Shipping and Handling - You would only really use thisif
you want to change the selected shipping method after
receiving the order. Change the shipping classin the 'Class'
field at the bottom right, and then click 'Update Order
Shipping'. You can also manually enter a shipping charge
into the'Calculated’ field.

Taxes - View thetax chargesincurred by the order.

Totals - For reviewing any changes you have madeto the
order

Progress and Payments - Where you can view the order
status and enter/ edit payment information.

Misc. - Thisiswhere you can check any supplementary
information provided with the order such as purchase order
number, or answersto the 'General Information' questionsin
the checkout.

Mail - View the emails generated regarding thisorder. You
can also send any pending emails, and generate new ones.

Journal - For making notes about the order.
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Monitoring Stock

Actinicincludes a'stock monitoring' feature that helpsyou keep track of
the stock level of the productsin your store. Stock levels are reduced
when an order for that product isdownloaded into Actinic.

You can enter stock levelsfor products by going to the 'Stock' tab of a
product and filling in the 'Estimated Stock In Hand' field. You will also
need to make sure the 'Stock Monitoring' checkbox is enabled.

You can also get an overview of the stock levels of all the productsin
your store by going to 'Operations| Stock Levels' or by clicking the

icon on the toolbar. This allows you to quickly add/ review stock levelsin
Actinic across a number of products.

There are two stock warning levels for Actinic:

Warn If Below - if the stock level of a product falls below
thislevel, you will receive awarning when you download
orders.

Suspend If Below - if the stock level of aproduct falls below
thislevel then the add to cart button will be replaced with an
'OUT OF STOCK' message.

You can set default values for these two stock warning levelsin 'Business
Settings| Options.

By default, none of the productsin the example store are stock
monitored.

Exercise - Stock Monitoring

Thiswill simulate what happenswhen a product goes out of stock.
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1. Gotoyour 'Running Shoes product you created earlier.
If you don't havethis product, you can use any product.

2. Switch to the 'Stock’ tab.

3. Setthestock level at '20'.

4. Click '‘Apply changes.

Thisproduct isnow stock monitored. If you place atest order for this
product the stock value will go down.

5. Now changethe stock level to '1' and click ‘Apply Changes'.

6. You should find that the add to cart button has been replaced
with an 'Out Of Stock' message.

7. Now goto'Operations| Stock Levels.

8. Changethe 'Select Product Type' drop down to 'Ordering
Suspended' to seethe product you have just put out of stock.

You would now need to upload the storein order to see the product
marked as being out of stock online.

More Information - Stock Reports

There are afew reportsavailable to help you monitor stock levelsin your
store. If you go to 'Operations| Report Selection' thereisa'Catalog' tab
that features four 'Stock Level' reports. You can print theseto help you
monitor the stock levelsin your store.
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Entering New Orders

Aswell asreceiving orders from your online store, Actinic also allows
you to enter orders straight into the program. This allowsyou to also
take orders over the phone or viafax, and keep all the order information
in one place.

Exercise - Adding a New Order Into Actinic

This exercise will show you the basics of entering a new order into

Actinic.

© N o O

Gotothe'Orders tab and go to 'Operations| New Order' (or
click the 'New Order' button at the bottom of the tab).

On thefirst screen select 'Shopped Before'. Thiswill save you
alot of typing later on.

Click the 'Search' button and then click the 'Search’ button on
the new window. This should giveyou alist of all the orders
currently in Actinic.

Select an order and click 'Select'.

Click 'Next >'to moveto the next screen.
Review the contact information and then click 'Next >'.
Thisscreen iswhereyou add itemsto the order. Click 'New'.

From the'Select Product' drop down list select 'Set of
Glasses'.

In the 'Components/ Attributes' window select the '8 Glasses'
option.
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10. Click 'OK" and then click 'Next >'.

11. Thisscreen iswhereyou can select the shipping method and
enter payment information. Make sure 'Payment Method' is
set to 'Credit Card' and select 'Type' of 'Visa'.

12. For the'Number' enter '1111222233334444'.
13. Select avalid 'Expiration Date' and click 'Next >'.
14. Click 'Confirm'to complete the new order.

Your new order should now be added to thelist of ordersin the
'Pending' tab.

Exercise - Editing An Existing Order

It is possible to edit an order to add new items. This exercise will show
you how.

1. Double-click on an order in the 'Orders' tab.
2. Changetothe'Line ltems' tab.
3. Click the'Add New Item' button.

4. Click 'New' and add the 'Far From the Madding Crowd'
product to the order. Click 'OK".

5. Click 'Next >'then click 'Next >' again and then click
'Confirm' to complete the addition.

Your new book should now bevisible within the'Line Items' tab.

More Information - Settings in Business Settings

If you go to the'Order Processing' tab within ‘Business Settings' you will
seethere arefew settings here under the heading of 'Offline Order
Processing'.

Select 'Allow Unit Price Override' if you want to be able to change the
price of itemswhileyou create new orders.

You can also choose a different prefix for the offline order numbersin the
‘Order Number Prefix' field.
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Regular Customers

Using Actinic, you can set up customer accounts for your regular
customers. Thisallows customersto log into the store with a username
and password, and havetheir name and addressinformation preset in
the checkout.

If you are using Actinic Business/ Designer you can go further and group
your customersinto 'Customer Groups'. You can then assign discountsto
these customer groups and also hide products from certain groups of
customers.

Exercise - Creating A Customer Account
This exercise will show you how to create a basic customer account.

1. Goto'Operations| Customer Accounts or click the icon
on the toolbar.

2. Click 'New Customer'.
In the'Name' field enter 'Test Account'.

4. Click the'Copy Details From Order Contact' button. This
showsyou all the order contact information already in
Actinic.

5. Double-click on one of the namesin thelist. Thiswill
populate therest of the fields here - and saves some typing.

6. Changeto the'Addresses' tab. This has been pre-populated
with the order information brought in by the previous step.

7. Changeto the'Buyers'tab and click 'New'.

A 'Buyer' isacustomer who will actually log into this account with a
username and password.

8. Changethe'Login', 'Password' and 'Confirm' fields all to be
'a'. Thisis so you can log into the store quickly to test this.
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9. Click 'OK".

Your new account has now been created. To test this, upload the store
and click the'Login' link. Then enter ausername and password of 'a’ to
log into the account. Add something to your cart and checkout to see the
preset address information.

Exercise - Creating A Customer Group
Actinic Business/Designer Only

You will now create a'Trade' customer group, who will receive a 20%
discount when they log in.

1. Goto'Marketing| Customer Groups or click the  button
in the toolbar.

2. Click 'New' and enter aname of 'Trade'.

3. Highlight your 'Test Account' account and use the '<' button
to moveit to the left '"Associated Accounts' column.
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4. Click the'Customer Pricing' button, and click 'OK' on the
window that appears.

5. Highlight 'Trade' in thelist and select 'Multiply By'.

6. Inthefield enter '0.8" and click 'OK". Thiswill give a 20%
discount.

Now upload the store and log in to test the discount for 'Trade'
customers. You should see both a'Retail Price' and a'Your Price'
appearing in the store.

More Information - Sophisticated Buyer Options

Go back to the "Test Account' account in Actinic and look at the 'Buyers'
tab. There are quite afew useful options here:

Select 'Hide Retail Prices' if you only ever want this buyer to
see asingle price (rather than "Your Price' and 'Retail Price').

Select 'Allow User to Select or Enter aNew Address' if you
want to allow your customersto enter their own new
addressesinto the store, aswell asusing a saved address
online.

You can enter a'Maximum Order Value' for this buyer if you
want to limit the amount they can spend on an order.
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Designing Your Store

Please note that the following features are not availablein 'Client’
versions of Actinic.

Choosing A Theme

A themeisaquick way to assign a new look and feel to your store. It is
worth experimenting with the themes that are available so you can find
oneyou like - and then use that as a starting point for any further
customisations.

Exercise - Changing Theme and Colour Scheme

This exercise will just use simple settings to change the look and feel of
your store.

1. Goto'Design| Themes.
2. Inthe'Themes' list, changeit to "Technical'.
3. Inthe'Color' list, changeit to 'Cool Red'.
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4. Click 'OK".

Thishas now applied a new look and feel to your store, but you can
change each individual element at a much more granular level.

Exercise - Changing Different Elements of a
Design

Thiswill show you how to change the default product layout for your
entire store, and also show you how the'Advanced Themes
Configuration' works.

1. Goto'Settings| Site Options.
2. Gotothe'Layout'tab.

3. Under the'Product' sub-heading, find the 'Product Layout'
setting.

4. Changeittoread 'Standard With Image On Left'.

5. Click 'OK".

You should now find that your products have changed appearance
slightly.
6. Go back to 'Design | Themes' and click '"Advanced Themes
Configuration'.

7. Changeto the'Buttons' tab and select '‘Basic Coloured
Buttons'.
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8. Click 'OK".

Your add to cart buttons should now look different.

Getting Started Guide Designing Your Store - 61



Choosing Alternative Layouts

It is possible to select different layouts for every singleitem you seein
the content tree. Thisis done by going to the 'Layout’ tab of theitem in
guestion, and selecting an alternative layout.

Very often a setting will have the words 'Use Parent' in it.

'‘Use Parent' simply means that the value for this setting is set somewhere
‘higher' up the Actinic structure, and the value isinherited down the
store structure. If you click on a setting it will usually tell you wherethe
value has been set in the areaunderneath the grid of settings.

When thevalueiscoming from 'Settings| Site Options, you can edit it
by going to 'Settings | Site Options' and then go to the 'Layout' tab.

When it saysthevalueis coming from the 'Variable Definition' you can
still change the value by going to 'Settings| Site Options| Layout' - it
just meansthat the value has been set in the default Actinic program
settings.

Exercise - Changing Layouts

This exercise will show you a selection of changes you can make within
Actinic. To begin with, you will change the way section links appear.

1. Goto'Settings| Site Options and change to the'Layout' tab.

2. Under the 'Section' sub-heading, locate the 'Section Link
Layout' field.

Changethelayout to 'Section Name Only Section Link'.
4. Click 'OK".
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To best see the effect of the new section link layout, click on the green
'Online Catalogue€' icon in the content tree.

Next, you will changethe way all the prices appear in the store. You will
change Actinicto show pricesincluding tax.

1. Go back to 'Settings| Site Options| Layout'.

2. Under the'Product' sub-heading, locate the 'Price Layout'
field.

3. Changethistoread 'Standard Tax Inclusive Price'.
4. Click 'OK".

Look at your productsto see the effect. Your product prices are now
shown including tax.

Now, you will changethe layout of a specific product in the store.

1. Gotothe'Starter Computer Bundle' product in the
'‘Computers' section.

2. Gotothe'Layout'tab.

3. Changethe'Product Layout' to be 'Standard With Image On
Right'.
The 'Sarter Computer Bundle' now looks different from the other
product in the section.

Finally, you will change the layout of the choices for the running shoes.

1. Gotothe'Running Shoes product within the 'Sportswear'
section

Thiswas created in the exercises at the beginning of thisguide. If you
don't have this product, then usethe'Basic T' product within the
'Clothing' section.

2. Click on the'Sze' attribute and go to the 'Layout' tab.

3. Changethe'Attribute Layout' to 'Standard Radio Button
Attribute'.
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4. Changethe'Column Count For Radio Buttons'to '2'.
5. Click 'Apply Changes' to see theresults.

Feel free to experiment with any of the settingsin the 'Layout’ tabs within
Actinicto seethe effect.

Exercise - Further Layout Changes

Here are some examples of further layout changes you can make in the
'‘Layout’ tabsin Actinic. To begin with, you will change the look and feel
of the main area of one of the sectionsin the store.

1. Gotothe'Clothing' section in the store and go to the 'Layout'
tab.

2. Under the'Section’ sub heading, change the 'Main Product
Area Layout' setting to be 'Standard Section Page'.

3. Click 'Apply Changes'.

This gives adifferent look and feel to this section.

Next, you will put the productsin the storeinto two columns.
4. Goto'Settings| SiteOptions| Layout'.

5. Under the'Product' sub-heading, locate the ‘Column Count
For Products' setting.

6. Changethisto '2' and click 'OK".

This putsyour productsinto two columnson the page.
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You may want to experiment with different product layoutsto see which
oneworks best in this configuration.

Finally, you are going to change the layout of the section list that appears
on the front page of the store.

7. Goto'Settings| SiteOptions| Layout'.

8. Under the 'Section' sub-heading, locate the 'Top Sub Section
List Layout' setting.

9. Changethistoread 'Sandard Sub Section List'

10. Click 'OK".

Now click on the green 'Online Catalogue€' icon in the content treeto go
to the store front page. The horizontal lines should be gone from the list
of sections.

Books
Clathirg
Spoartswear
Homeweare
Computers
Stationery
Best Sellers
Iy Products

More Information - Layout Selectors

The layout selection drop-down listsin Actinic are all controlled by
thingscalled 'Layout Selectors'. It is possible to edit the layout selectorsin
Actinic to change the order of layoutsin thedrop-down list, remove
layouts and even add your own custom layouts.

Thisisdescribed later onin “Adding New Layoutsto Actinic” on page
79.
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The Design Tab

The 'Design' tab isused to change the look and feel of specific elements of
your page design.

Itisdivided into three main areas:

Interactive Preview - Click on anything in the preview and a
dotted line will appear around it. If a piece of text is selected,
you will be able to change the appearance of it with the
formatting controlsin thetoolbar abovethe interactive
preview. Also, the HTML that lays out the part of the page
you have selected will appear in the'Layout Code' panel at
the bottom.

Layout Code - This shows you the code of whatever you
haveclicked on in the preview. You can edit the code here
and click 'Apply' to see the effect on the preview. At the
bottom of this panel are two tabs where you can change
between the 'Layout Code' tab and the 'Details' tab (where
you can edit names, descriptions, etc.)

The Content Tree/Design Tree Panel - Down the right-hand
side of the Design tab isa narrow vertical panel that either
contains the Content Tree or the 'Design Tree' - depending

on what tab is chosen at the bottom of the panel. The Content
Tree allowsyou to quickly changethe section you are
viewing in the Design tab. The Design Tree showsyou all the
layouts that make up the current page.

If you want to select a section to edit, use the Content Tree. If you want to
edit apagethat isn't asection (including email and style sheet layouts)
then usethe 'Select Page Type' drop down at the top left of the Design
tab.
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Exercise - Changing Fonts

This exercise will show you how to usethe Design tab to change the
appearance of thetext in your store.

1. Gotothe'Homeware' section.
2. Click on the 'Teapot' product namein the preview.

3. Clickonthe iconinthepreview toolbar to make the
product nameitalicised.

4. Click onthe icon and then choose an alternative colour for
the product names.

You can do thiskind of text formatting for any text in the store.
5. Now click the'Undo' icon on the toolbar - <2
6. Thisshould reverse out the colour change.

7. Now select adifferent colour.

Notice that the change you made changed all the products on the page -
thisisbecausethey are all using the same layout. It will also change the
appearance of productsin other sectionsin your store.

Exercise - Using Panels

This exercise will help you understand how the panels on the Design tab
work.

1. Makesureyou areon the Design tab.

2. At thebottom right of the tab you should seetwo tabs called
'‘Content Tree' and 'Design Tree'. Click on the'Content Tree'
tab to make surethat the content treeis visible.

3. Click on the Running Shoes product in the content tree (or
click on any other product if you don't have the Running
Shoes.
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Locate the tabs at the bottom left of the Design tab and click
on the'Layout Code' tab to make surethat the layout codeis
visible.

In the preview, click on the Running Shoes product name.
This should highlight a piece of blue text in the layout code
that says 'ProductName'.

ProductHame

Now usethetabs at the bottom left of the Design tab to
switch to the'Product Details' tab.

In the 'General' tab, change the short description to read
'Running Shoes- New!" and click 'Apply changes'.

This should change what appearsin the preview.

In other words, this has changed the text which isinserted into the
design by the variable called 'ProductName'.

You'll learn more about variablesin the next section.
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Inserting Variables into the Design

When you are looking at the layout codein the Design tab, aswell as
standard HTML code, you will also see 'variables'.

A variableis aplaceholder for a piece of Actinic data. For example, if you
click on aproduct namein theinteractive preview, it highlightsa
variable called 'ProductName'. In the layout code they appear in blue.

ProductHame

You can usethe'Insert Variable' toolbar button at the top of the layout
code panel to add new variablesinto the design.

]

Exercise - Adding a Variable Into the Design

Thisisabasic exercise that will show you the principle of adding a
variableinto alayout in Actinic. It will add the current section
description at the top of each section page.

In order to do this exercise you need to have the name of the section at
the top of the section.

If you don't havethis, go into a section in your store, and in the 'Layout’
tab, changethe'Main Product Area’ setting to be 'Section Page With
Section Name At The Top'.

1. Inthepreview in the Design tab, click the section name at the
top of the page.

2. Thisshould highlight avariable called 'SectionName' at the
top of the section.

3. Add anew blank line after thisline.

4. Put your cursor in the new blank line and click the 'Insert
Variable' button -

5. Inthe'List Names Containing' box, type 'Section’'.
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6. Locate'SectionDescription'in thelist and click 'Insert'.
7. Click 'Apply'.

This hasinserted the section description at the top of each section page.

Exercise - Looking Up A Variable

If you ever need to find out what avariable does, and where you can set
thevalue of it, you can use the 'Variable Reference Guide'. This exercise
will show you how.

Asan example, let's say you needed to find out more about the
'SectionDescription' variable.

1. Goto'Help | Variable Reference Guide'.

2. Changeto the'Search' tab.

3. Type'SectionDescription' and click 'List Topics'.
4. Doubleclick on thefirst item in thelist.

This gives you a short description of the variable, and tellsyou wherethe
value of the variable can be set.

You can also usethe'Contents' tab to browse by product area.
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More Information - Typing Variable Names

It isalso possibleto add avariableinto alayout by starting to typethe
variable nameinto the layout.

After typing three or four letters, awindow will appear that showsyou
the possible variables to insert.
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Creating New Variables

Actinic allowsyou to create any number of custom settings for theitems
in your content tree. Examples of thisinclude an 'Artist' field for CDs, a
'Sarring' field for DVDs, or an 'Author’ field for books. These custom
settings arereferred to within Actinic as 'User-Definable Variables', and
they appear within gridslikethis:

You can then include these custom settingsinto your store designs by
inserting the variable into the layouts, as discussed earlier.

Exercise - Creating a New Variable

In thisexercise you will add a new 'Author’ variable within Actinic, and
then includeit into the design.

1. GototheDesign tab and then make sure you are looking at
the 'Books' section.

2. Click on the name of one of the books on this page. This
should highlight the'ProductName' variable.

3. Addinanew blank line straight after the variable.
4. Inthenew blank line, type<br />

You might notice that Actinic promptsyou here to complete thetag. This
isafeatureof Actinic-it will help you create the HTML within the
layouts.

5. lust after the<br / >right-click and select 'Insert Variable'.

6. Click the'New' button on the window that appears.
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7. Inthe'Name' field, enter 'Author'.

8. Inthe'Description' field enter 'New field for the author of the
books'.

9. Inthe'Prompt' field enter 'Enter Author Name'.
10. Under 'Place Of Setting' select 'Product’'.
This meansthat the new field will appear for your products.

11. De-select 'Allow <Use Parent> as an Option'.
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12. Click 'OK'" and then click 'Insert'.
13. Click 'Apply".

You can now changeto the Content tab in Actinic and enter the author
valuein for thethree books. You will find the new field within the
'Properties' tab.

If the author value has not appeared for all your books, it may be because
your books are using different layouts from each other. You may need to
insert the<br />Aut hor in morethan onelayout.

Exercise - Limiting By Content Category

Go to aproduct in the 'Clothing' section and look at the 'Properties' tab.
You'll seethat currently, the'Author' field is appearing for all the
productsin the store. However, you only need it to appear for your
books. It is possible to limit custom variables to specific products by
using afeature called 'Content Categories'.

You are going to create a new 'content category' in your store called
'Books' and then restrict the 'Author’ field to only appear for that content
category.

1. Goto'Design| Content Categories'.
2. Highlight '‘Product'.
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3. Click 'New' and enter a category name of 'Books'.

4. Click 'OK".

5. Gotothe'General' tab of each of your books and change the
'Category' field to 'Books'.

You arenow going to limit the'Author' field to only appear for this
books category.

6. IntheDesign tab, click on an author namein the preview,
then right-click on it and select 'Edit Variable'.

7. Changeto the'Advanced Place Of Setting' tab.
8. Click the'+' next to 'Product’

9. De-select 'Sandard'.

10. Click 'OK".

Your 'Author’ setting should no longer appear for the productsin your
store that are not books. To check this, look at a product in the 'Clothing'
section and check the 'Properties' tab. The'Author' field should no longer
bethere.

More Information - Lists of Choices

When you are creating a new variable, you can changethe 'Type' field to
‘List of Choices. Once you do this, the 'Values' tab becomes activated and
you can preset alist of choicesfor thisvariable.
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Editing Layouts

The Layout Code panel within the Design tab can also be used for
making general HTML changesto your layouts, and also inserting new
layouts within your layouts.

Exercise - Making HTML Changes To Layouts

This exercise will guide you through abasic HTML changeto alayout,
and show you how to changeit back to how it was before.

1. Locatethe'Product Sections' section list that isin the sidebar
of your page.
2. Click on the'Books' link within thislist.
Thiswill open the 'Section Name Only Section Link' layout in the layout

code panel. The'SectionName' variable should be highlighted within the
layout.

If you cannot seeany HTML code, try clicking on the'Layout Code' tab
at the bottom left of the Design tab.

3. lust after the'SectionName' variable, add three dots'..." and
click 'Apply".

4. You should seethethree dots after each section link in the
preview.

5. Now replacethe'..."with a'>"and click 'Apply".

6. Now click the'Undo' (£3) button on thetoolbar twice to
cancel both changes.

This shows how it is possible to experiment and tweak the layoutsin
Actinic without worrying about not being able to go back.

Please note though that once you leave the Design tab, or make any
changesto your product data (such as changing the product name etc.)
you will not be ableto undo your design changes.

More Information - The Library

If you goto 'Design | Library'you will seethe'Library'. Thisiswhere
you can manage all the layouts and variablesthat arein Actinic.
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In the'Layouts' tab of thelibrary, layouts (and layout
selectors) are all grouped by 'Type' - and thetypes are sorted
alphabetically.

In the'Variables' tab of thelibrary you will see all the
variablesin the design that are editable.

The 'Conditions' tab is discussed later in “Using Conditions”
on page 85.

You can usethelibrary to edit and rename the elements that make up
your design.

You can also create new layouts, as discussed in the next chapter.

More Information - The Design Tree

Layouts are alwaysinserted into other layouts, which creates a hierarchy
of layouts within the page. Thisiswhat isshown in the Design Tree at
theleft hand side of the Design Tab. It showsyou the hierarchy of
layouts that makes up the page design that you are currently working on.

78 - Designing Your Store Getting Started Guide



Adding New Layouts to Actinic

It issimpleto add your own new custom layoutsto Actinic. Thisis useful
if you want to experiment with changing layouts without affecting the
default layoutsthat came with Actinic.

Exercise - Creating a New Product Layout

This exercise will show you how to add your own custom product layout
to Actinic.

1. Changeto the'Content' tab.

2. Select the 'Running Shoes' product you created earlier. If you
don't havethis product, then you can use any product in the
store.

3. Changeto the'Layout' tab and locate the 'Product Layout'
field.

4. At thebottom of the'Product Layout' drop down list you
should see a <N ew> option. Select this option.

For the name of the new layout enter 'Sale Layout'.
In the 'Based on' field, select 'Standard With Image On Left'.
Click 'OK".

© N o O

Make sure'Sale Layout' is selected in the 'Product Layout'
field.

9. Click 'Apply changes.

The product won't look any different at the moment. Thisis because you
haven't made any changesto the layout yet. You can now switch to the
Design tab and customise your new 'Sale Layout' layout.

10. Changeto the'Design' tab.

11. Usethecontent treeto select the product you have just been
editing.

12. Click on the product namein theinteractive preview.

You should bein thelayout called 'Sale Layout' and avariable called
'‘ProductName’ should be highlighted.

13. Just after it, type' - ON SALE'.

14. Click 'Apply' and then click 'OK".
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Thiswill include an 'on sale' message to any product that isusing the
'Sale Layout'.

Exercise - Looking at Layouts in The Library

This exercise will show you how to find layoutsin the Library, and also
how to change where the new 'Sale Layout' appearsin the '‘Product
Layout' drop down list.

1. Goto'Design| Library'and changeto the'Layouts' tab.
2. Right-click anywhere within thelibrary and select 'Find".
3. Inthe'Search for Text' field, type 'Sale Layout'.

4. Click 'Find Next Item'.

Thiswill highlight your new 'Sale Layout' layout. It iswithin the
'Products' group.

It isnow possibleto edit the 'ProductLayout’ layout selector - which
controlsthe drop down list where you select the product layout. Layout
selectors have the following icon -

You aregoing to move 'Sale Layout' to thetop of thedrop down list.
1. Double-click on the 'ProductLayout' layout selector.
2. Changeto the'Values tab.

3. Highlight 'Sale Layout' and usethe arrowsto moveit to the
top of thelist.

4. Click 'OK".

The new 'Sale Layout' layout will now befirst in thelist of product
layouts offered by the 'Product Layout' setting.

5. Gotoany product in your store.
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6. Inthe'Layout' tab, changethe'Product Layout'to 'Sale
Layout'. It should bethefirst layout in thelist.

7. Click 'Apply changes'.

More Information - Deleting and Restoring
Layouts

If you have created alayout that you no longer want, you can right-click
onitintheLibrary and select 'Delete'’. If the 'Delete’ option isgreyed out
for any reason, thisis because the layout isbeing used somewherein
your store, so you need to make sureit isn’t selected in 'Site Options' or
anywherein the content tree.

If you have made a change to one of the layoutsthat came with Actinic,
and you want to put the layout back to how it was originally, you can
right-click on alayout in thelibrary and select 'Revert to Factory
Settings'.

It isalso possible to create new layouts whileyou arein thelibrary.
Simply right-click on alayout and select 'New Layout'.
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Inserting Layouts Into Your Design

When you are looking at the layout code within Actinic, aswell as
standard HTML code and variables, you will also see things that look
like this:

AddToCartButton

These are 'layout selectors' in the design. Layout selectorswork like
variables, but rather than inserting text into alayout, they actually insert
alayout within the current layout.

You can use the toolbar button at the top of the layout code panel to add
new layout selectorsinto thedesign.

]

Exercise - Adding a New Navigation Link

This exercise will add a new 'Terms and Conditions' link to the store
navigation bar.

To do this exercise, you need to be using the 'Technical' theme. Please
change to thistheme if you are not on it already.

1. Intheinteractivepreview, click on the'Search' button
halfway down thelist of buttonsin the sidebar.

2. You should now seethe code of the 'Search' button in the
Layout Code panel at the bottom of the Design tab.

3. Click the'Navigate To Parent Layout' button - - inthe
toolbar that isunderneath the layout code. This should take
you to the 'parent layout', which is called '"Works Best With
Technical'. If it doesn't take you there, try clicking it again.

You are now looking at the layout selector that inserts the 'Search' button
into the design.

4. Addinanew blank lineunderneath the 'Search CSSLarge
Button' layout selector.

5. Put your cursor in the blank line created and click the 'Insert
Layout' button on the toolbar -

6. Inthe'List Names Containing' box, enter 'nav'.

7. From thelist at thetop of thewindow, select
'Navigationlcon'. Thisisthe layout selector you are going to
insert.
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You could just insert the layout selector asit is, but this gives you no
control about the actual layout that will be inserted into the design.
Instead, you are going to 'fix' the layout so a specific layout will be
inserted by this layout selector.

8. Select the'Use Fixed Layout' box.

9. From thelist of available navigation icon layouts, select
'Terms CSSLarge Button'. The layoutsarein alphabetical
order.

10. Click 'Insert'.

11. Click 'Apply'to seeyour new layout in action.
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More Information - Fixed Layouts

If you ever want to change the layout that isbeing inserted by alayout
selector, simply right click on the layout selector in the code and select
'Edit Appearance'. You can then select the layout with the 'Use Fixed
Layout' setting.

When alayout selector isn't using a fixed layout, it generally meansthe
layout can be selected within the'Layout' tab in 'Settings| Site Options),
or within the 'Layout' tab of a product, or section. In the chapter called
“Adding New Layoutsto Actinic” on page 79 you'll find out how to edit
thelayout selectorsin Actinic to change the range of layoutsthat are
available for you to select from.
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Using Conditions

'‘Conditions' allow you to show/ hide pieces of your layout based on
settingsin Actinic. They allow you to not just change the way Actinic
looks, but also change theway Actinic works.

Conditionsin Actinic look likethis:
block if

fhlock

The text between thetwo 'block' tags will only be shown if the condition
statement is'true'. You can specify the condition statement using
variables and rules that control when to display the text.

If you ever want edit a condition statement, double-click on the opening
'block’ tag. This shows you the condition that must be 'true' in order for
the text to appear.

Exercise - Creating A Condition Based On Stock
Level

This exercise will include a simple message into the product layout based
on the stock level of the product.

1. IntheDesign tab, select any product layout by clicking on a
product name.

2. Seroll to the bottom of the layout code of that product layout
until you find 'ProductRelatedProductsList'.

3. Add ablank linejust below thisline.
4. Inserta<br />intothisline.

Then enter the following text 'This product isrunning low on
stock. Please call usto check availability'.

6. Click 'Apply'. Thetext should appear for some or all of the
productson this page.

7. Now highlight the entireline you entered and click the
'Insert Block' button on the layout code toolbar -

8. Thiswill open the 'Expression Editor'.
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You are going to create a condition that says 'the product is stock
monitored AND thereislessthan 10 of them in stock'.

9. Sart typing 'IsStock...". You should see Actinic prompting
you toinsert avariable. Select 'IsStockM onitored' by pressing
'Enter' on your keyboard.

10. Now click the'Insert an operator into expression' button and
select 'And' from the drop-down list provided.

11. Typeastandard left bracket - '('

12. Now start typing 'StockLevel'. When Actinic prompts you to
enter the 'StockLevel' variableinto the design, press 'Enter’
on your keyboard.

13. From the'lnsert Operator...' list, select 'Less Than'.

14. Now type'10' (without the quotes) and enter a standard right
bracket - )’

15. Click 'OK".
16. Click 'Apply' to confirm the changes.
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Now changeto the'Content' tab to test this change.

17. Goto any product in the content tree and go to the 'Stock’
tab.

18. Select 'Stock Monitoring' and enter an 'Estimated Stock In
Hand' of '6'.
19. Click 'Apply changes'. The stock message should bevisible

in the preview. It will be underneath your list of ‘also bought'
products, if you have one displayed.

20. Now changethe 'Estimated Stock In Hand' to '20" and click
'‘Apply changes'.
The stock message should disappear.
Thisisacondition based on stock level. You can also create conditions
that are based on whether or not a setting has been filled in by using the

'IsNot Empty' operator. For example, the following condition will hide
code unlessthe'Author’ field has been filled in.

More Information - Reusable Conditions

The 'Conditions' tab of the Library isused to store reusable conditions.
Asan example, go to the 'Product’ group within the Conditions tab and
double-click on 'IsAddToCartButtonShown'.

This showsyou all the conditionsthat must be met in order for the add to
cart button to appear. You can see wherethisreusable condition is used
in the design by double-clicking on the block tags that surround the
'‘AddToCartButton' layout selector in your product layouts.
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Content Lists

Sometimes a layout needsto beinserted multipletimesinto adesign. For
example, a product layout needsto beinserted multipletimesinto a
section page, depending on how many products arein the section. When
this happens, Actinic uses a'list' to control the insertion of the layout into
the page.

If you look in the Design Tree, lists have the following icon -
The best way to select alist for editing is:
1. Select anitem in the design that isbeing laid out by alist.

2. Click the'Navigateto Parent Layout'icon - - to select the
list.

To then edit the list layout, click the 'Edit List Layout Settings' button, or
click the orange 'Click here to edit list layout settings' link at the top of
the layout code.

Exercise - Editing A List

This exercise will show you how to change the layout of the 'New
Products' list that isin the sidebar.

If you don't have anew productslist in the sidebar, use the best sellers
list.

1. Click onthe'New Products text that's at the top of the new
productslist in the sidebar. Thiswill select the entirelist.

2. Click the'Edit List Layout Settings' button.

3. Click the'Edit' button next to the 'Start of List' field.
4. Changethe'New Products' text toread 'New This Week'.

5. Click 'OK'"and then click 'Apply'.
This should change the text that appears at the top of thelist.

More Information - Editing List Items

If you want to edit the formatting of the actual itemsin thelist, then you
need to switch to the 'Edit Rows/ Columns' tab within the list layout
settings.
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